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21  SUMMARY:
22 Serial Block-Face Scanning Electron Microscopy (SBEM) is applied to image and analyze dendritic
23 spinesin the murine hippocampus.
24
25  ABSTRACT:
26  Three-dimensional electron microscopy (3D EM) gives a possibility to analyze morphological
27  parameters of dendritic spines with nanoscale resolution. In addition, some features of dendritic
28  spines, such as volume of the spine and post-synaptic density (PSD) (representing post-synaptic
29 part of the synapse), presence of presynaptic terminal, and smooth endoplasmic reticulum or
30 atypical form of PSD (e.g., multi-innervated spines), can be observed only with 3D EM. By
31 employing serial block-face scanning electron microscopy (SBEM) it is possible to obtain 3D EM
32 data easier and in a more reproducible manner than when performing traditional serial
33  sectioning. Here we show how to prepare mouse hippocampal samples for SBEM analysis and
34  how this protocol can be combined with immunofluorescence study of dendritic spines. Mild
35 fixation perfusion allows us to perform immunofluorescence studies with light microscopy on
36 one half of the brain, while the other half was prepared for SBEM. This approach reduces the
37 number of animals to be used for the study.
38
39 INTRODUCTION:
40 Most of the excitatory synapses in the central nervous system are located on dendritic spines -
41  small protrusions of a neuronal membrane. These protrusions form confined biochemical
42  compartments that control intracellular signal transduction. Structural plasticity of dendritic
43  spines and synapses is closely related to the functional changes in synaptic efficacy that underlie
44  such important processes as learning and memory? 2. It is important to note that electron
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microscopy (EM) is the only technique that allows to determine if a dendritic spine has a
presynaptic input. EM resolution is also needed to study ultrastructural details such as shape of
a postsynaptic density (PSD), representing a postsynaptic part of a synapse, or dimensions of a
dendritic spine, as well as the size and shape of an axonal bouton. Additionally, with EM it is
possible to visualize synapses and their surroundings.

Thanks to advances in imaging and computing technologies it is possible to reconstruct entire
neural circuits. Volume electron microscopy techniques, such as serial section transmission
electron microscopy (ssTEM), serial block-face scanning electron microscopy (SBEM), and
focused ion beam scanning electron microscopy (FIB-SEM) are commonly used for neuronal
circuit reconstructions3.

In our studies, the SBEM method is successfully employed to investigate the structural plasticity
of dendritic spines and PSDs in samples of the mouse hippocampus and organotypic brain slices
45 The SBEM is based on the installation of a miniature ultramicrotome inside the scanning
electron microscope chamber®=2. The top of the sample block is imaged, and then the sample is
cut at a specified depth by the ultramicrotome, revealing a new block-face, which is again imaged
and then the process is repeated?. As a result, only the image of a block-face is left while the slice
which has been cut is lost as debris. That is why SBEM is called a destructive technique, meaning
it is not possible to image the same place again. However, the advantage of the destructive on-
block methods is that they do not suffer from warping problems and section loss that can
significantly affect the data quality and the data analysis®. Moreover, SBEM gives the possibility
to image a relatively large field of view ( > 0.5 mm x 0.5 mm) at high resolution3.

To employ SBEM, samples have to be prepared according to a dedicated, highly contrasting
protocol due to the backscattered electron detector used for acquiring images. We show here
how to perform sample preparation according to the protocol based on a procedure developed
by Deerinck!® (NCMIR method), using reduced osmium-thiocarbohydrazide-osmium (rOTO)
stains developed in the 1980s% 1. In addition, we introduce a two-step fixation approach, with
mild fixation perfusion that allows to use the same brain both for immunofluorescence studies
with light microscopy and SBEM.

In the protocol a mouse brain is primarily fixed with a mild fixative, and then cut into halves, and
one hemisphere is postfixed and prepared for immunofluorescence (IF), while the other for EM
studies (Figure 1).

[Figure 1 here please]

PROTOCOL:

The research was performed in compliance with Nencki Institute guidelines and permission of
the Local Ethical Committee. The studies were carried out in accordance with the European

Communities Council Directive of 24 November 1986 (86/609/EEC), Animal Protection Act of
Poland and approved by the first Local Ethics Committee in Warsaw. All efforts were made to
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minimize the number of animals used and their suffering.
CAUTION: All procedures described below must be carried out in a laboratory fume hood. Due to
the hazardous nature of the reagents used. Personal safety measures such as gloves, lab coat,

safety glasses and a face mask are required.

1. Preparation of the fixative for perfusion (2% wt/vol paraformaldehyde (PFA) and 0.5%
vol/vol glutaraldehyde (GA) in 0.1 M phosphate buffer (PB), pH 7.4)

NOTE: Prepare the fixative solution on the same day as it will be used and do not store it longer
than for 3 hours. In case of time shortage, prepare 2% PFA in 0.1 M PB the day before, store it at
4 °C and add fresh GA shortly before the perfusion.

1.1. Take 400 mL of sterile double distilled water (ddH20) and heat it to 60 °C using a stirring
hot plate. Then add 20 g of PFA. Add drops of 1 M NaOH until PFA is fully dissolved and allow the
mixture to cool down.

1.2. Add 500 mL of 0.2 M PB (pH 7.4).

1.3. Filter the solution to remove any deposit and cool it to 4 °C.

1.4. Just before perfusion, add 20 mL of 25% GA to the solution and then top up the volume
with ddH,O to 1 L.

2. Preparation of postperfusion fixative for SBEM (2% wt/vol PFA and 2.5% vol/vol GA in 0.1
M PB, pH 7.4)

2.1. Take 50 mL of the fixative for perfusion (2% PFA and 0.5% GA in 0.1 M PB).
2.2. Add 5 mLof 25% GA.

3. Preparation of postperfusion fixative for IF staining (4% PFA in phosphate buffered saline
(PBS))

3.1. Dissolve a tablet of 1x PBS (pH 7.4) in a purified and deionized water (H20) according to
manufacturer instructions.

3.2. Use a stirring hot plate to heat the solution to 60 °C and add 40 g of PFA.
3.3. Adddrops of 1 M NaOH until the PFA is fully dissolved and allow the mixture to cool.
3.4. Adjust the pH of the solution to 7.5 with 1 M HCl then top up the volume with H,O to 1 L.

3.5. Filter the solution to remove any deposits.
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4. Transcardial perfusion of animals

NOTE: All PFA and GA wastes must be collected and stored for disposal according to the local
regulations. Anesthesia and perfusion should follow the local regulations. In the described
protocol adult 3-month-old and 20+1-month-old female Thyl-GFP(M) mice (Thy1l-GFP +/-)*2
expressing green fluorescence protein (GFP) in a sparsely distributed population of glutamatergic
neurons were used but any other can be used as well. Animals were bred as heterozygotes with
the C57BL/6J background in the Animal House of the Nencki Institute of Experimental Biology.

4.1 Before perfusion anesthetize a mouse by administration of a ketamine/xylazine mixture (up
to 90 mg/kg body weight ketamine and 10 mg/kg body weight xylazine) via intraperitoneal
injection (27-gauge needle).

4.1.1 Assess whether the depth of anesthesia is sufficient by checking the reflex to pain stimuli
(pinching) and the corneal reflex (squinting).

4.2 After 20 minutes perform an intraperitoneal injection (27-gauge needle) of sodium
pentobarbital (50 mg/kg body weight).

4.3 Perfuse a mouse according to a perfusion surgery protocol described by Gage et al.!? (see

point 4; Figure 5-6). Using a perfusion pump start with a 0.1 M phosphate buffer, pH 7.4 (30 mL)

for 3 minutes and continue with 2% PFA and 0.5% GA in 0.1 M PB, pH 7.4 for 6 minutes (80 mL).

4.3.1 Gently dissect the brain from the skull and divide it in half (see Figure 9-10 in Gage et al.,
2012%3). Place one piece in a vial containing fixative for SBEM and the second into the vial
with 4% PFA/PBS for IF staining.

4.3.2 Keep the hemispheres in the fixative at 4 °C overnight.

5. Brain slices preparation for electron microscopy

5.1 Choose the vibratome settings (blade travel speed: 0.075 mm/s, cutting frequency: 80 Hz).

5.2 Place the slice chamber into the holder, attach it to the vibratome and surround it with ice.
Then place a razor blade into the vibratome blade holder.

5.3 Use a spoon, or similar object and place the chilled brain (dorsal surface up) on a tough
cutting surface (e.g., a glass Petri dish lid). To prepare a coronal slice of the hippocampus make a
perpendicular cut between the cerebral hemisphere and the cerebellum with a razor blade or
scalpel, thus removing the cerebellum. The olfactory bulb can also be removed.

5.4  Apply cyanoacrylate glue on the dry platform of the vibratome.
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5.5 Pick up the brain with forceps and carefully dry it on filter paper.

5.6 Glue the hemisphere to the platform close to the cutting blade with the rostral tip upwards.
Attach the platform to the holder and immediately fill it up with ice-cold 0.1 M PB, pH 7.4. If the
perpendicular cut is properly made, the hemisphere will stand straight up providing 90° angle
required to make a symmetric coronal cut containing the hippocampus. Assure that the brain is
covered with PB.

5.7 Position the vibratome blade in front of the hemisphere and lower it to the coronal side of
the hemisphere. Lower the blade to 400 um further in the caudal direction and start slicing.
Continue slicing until the first two slices are completely separated from the tissue block.

5.8 Retract the blade and lower another 100 um, then slice again.

5.9 When the hippocampus becomes visible (use the mouse brain atlas Paxinos and Franklin,
2004 collect the slices with the small paintbrush or widened plastic Pasteur pipette.

5.10 Transfer the slices into a 12-well plate filled with cold 0.1 M PB, pH 7.4.

5.11 Dissect the hippocampus in a glass Petri dish filled with 0.1 M PB, pH 7.4 using a razor blade
or scalpel, and put it into glass vials with the same phosphate buffer.

NOTE: For long-term storage of the slices supplement 0.1 M PB with 0.05% sodium azide (NaNs).
6. Brain sample preparation for immunostaining

6.1 After overnight fixation in 4% PFA/PBS solution in a fume hood, put the brain tissue into
the cryopreservation solution (30% sucrose in PBS with 0.05% NaNs) and keep it at 4 °C for 2 days
(until sunk).

6.2 Prepare an antifreeze solution (15% sucrose/30% ethylene glycol/0.05% NaN3/PBS).

6.3 Set the cabinet temperature of the cryostat at -19 °C and make sure that the temperature
is reached before proceeding further. During sectioning, ensure that the cabinet temperature
remains between -18 °C and -20 °C.

6.4 Use a spoon, or similar object and place the chilled brain (dorsal surface up) on a tough
cutting surface (e.g., a glass Petri dish lid). To prepare a coronal slice of the hippocampus make a
perpendicular cut between the cerebral hemisphere and the cerebellum with a razor blade or
scalpel, thus removing the cerebellum.

6.5 Select a pre-cooled specimen disc, cover it with a medium for freezing on a freeing shelf
and using forceps fix the hemisphere to the disc with a rostral tip upwards and wait until the
specimen is completely frozen. Insert the specimen disc into a specimen head.
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6.6 Install a blade in a blade holder inside the cryo-chamber and cut 40 um thick slices.

6.7 Transfer slices with a small paintbrush to the 96-well plate filled with cold anti-freeze
solution and gently unroll the sections (collect a slice after each round of slicing to prevent them
from getting lost in the slice chamber).

NOTE: Brains or sections can be stored in an antifreeze solution at -20 °C for a long time.

7. Immunostaining of brain slices

NOTE: All staining steps were performed in a 24-well plate on a platform shaker.

7.1. Wash the slices with PBS three times, each time for 6 minutes.

7.2. Incubate slices in 300 pL of blocking solution (5% normal donkey serum (NDS)/0.3% Triton
X-100) for 1 hour with gentle shaking on a rotator.

7.3. Incubate the slices with the primary antibody against PSD-95 diluted 1:500 in 5% NDS/0.3%
Triton X-100/PBS (300 pL per well) overnight at 4 °C. The final concentration of the primary
antibody is 2 pg/mL.

7.4. Wash the slices with 0.3% Triton X-100/PBS at room temperature (RT) three times, each
time for 6 minutes.

7.5. Incubate slices with the secondary antibody diluted 1:500 in 300 pL of 0.3% Triton X-
100/PBS for 90 minutes. The final concentration of the secondary antibody is 4 pg /mL.

7.6. Wash the slices with PBS three times, each time for 6 minutes.

7.7. Mount the slices on slides using a mounting medium and then close them with a cover
slide.

7.8. Examine the specimens using a confocal microscope (63 x oil objective, NA 1.4, pixel size
0.13 um x 0.13 um).

NOTE: For long-term storage: keep the samples at 4 °C, protect them from light.

8. SBEM sample preparation

CAUTION: Due to the hazardous nature of reagents used all the procedures described below must
be carried out in a laboratory fume hood. Before using these chemicals read carefully the

Material Safety Data Sheets provided by the manufacturers and ask the safety officer about the
local rules to ensure safe handling and waste disposal.
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8.1. Sample contrasting

NOTE: Slices washings and room temperature incubation should be carried out with mild shaking
(e.g., on a platform shaker). Autoclave degassed water was used.

8.1.1 Wash the slices with cold 0.1 M PB, pH 7.4 five times, each time for 3 minutes.

8.1.2 Prepare a 1:1 mixture of 4% aqueous osmium tetroxide and 3% potassium ferrocyanide
(1:1 by vol). The final product will turn brown. Immerse the samples in this mixture, place them
on ice, and from this stage onwards it is important to protect them from light. Incubate them
with gentle shaking for 1 hour.

8.1.3 Meanwhile prepare a thiocarbohydrazide (TCH) solution. Mix 10 mL of double-distilled H.O
(ddH20) and 0.1 g of TCH and place it into an oven set at 60 °C for 1 hour. It is important to swirl
the solution from time to time (e.g., every 10 minutes). When ready, cool it to room temperature.

8.1.4 Wash the slices with ddH>0 five times, each time for 3 minutes.

8.1.5 Filter TCH solution using a 0.22 um syringe filter and immerse the sample in filtered
solution. The slices will turn black. Incubate them for 20 minutes at room temperature.

8.1.6 Wash the samples with ddH,O0 five times, each time for 3 minutes.

8.1.7 Incubate the samples with a 2% aqueous solution of OsO4 for 30 minutes at room
temperature.

8.1.8 Wash the samples with ddH,O0 five times, each time for 3 minutes.

8.1.9 Place the samples in filtered 1% aqueous uranyl acetate and incubate them at 4 °C
overnight. Use 0.22 um syringe filter for filtration.

8.1.10 Prepare L-aspartic acid solution by mixing 0.4 g of L-aspartic acid and 80 mL of ddH;0,
adjust the pH to 3.8 for easier dissolving, and then top up with water to 100 mL.

8.1.11 Next day, begin with Walton’s lead aspartate!® preparation. Mix 0.066 g of lead nitrate
with 10 mL of L-aspartic acid solution (point 8.1.10) pre-warmed to 60 °C and adjust pH to 5.5
(measured at 60 °C) with 1 M NaOH. Close the vial with lead aspartate and leave it at 60 °C for 30
minutes in a water bath. The solution should be clear. If it turns cloudy, it must be discarded and
a new one needs to be prepared.

8.1.12 In the meantime, wash the samples with degassed ddH,O five times, each time for 3
minutes. Then keep them in the oven set at 60 °C for 30 minutes.
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8.1.13 Immerse the samples in the freshly prepared lead aspartate solution and incubate them
in the oven set at 60 °C for 20 minutes.

8.1.14 Wash the samples with degassed ddH,O five times, each time for 3 minutes.
8.2. Dehydration and resin embedding

8.2.1 Prepare epoxy resin. Weigh the ingredients (33.3 g of component A/M, 33.3 g of
component B, and 1 g of component D) and mix the resin well (e.g., shake it on a rotary shaker
in a 15 mL tube) for at least 30 minutes before adding 16 drops of accelerator DMP 30. Stir again
for another 10 minutes.

NOTE: Weigh the ingredients under the fume hood. This amount of components gives
approximately 60 mL of resin what is enough for 15 vials with samples. You can prepare less or
store the rest of the resin in a syringe at 4 °C and utilize it the next day. Remember to seal the tip
of the syringe

8.2.2 Prepare vials with graded dilutions of ethanol (30%, 50%, 70%, 90%, 100%, 100% ethanol
in water and 100% dried on a molecular sieve).

8.2.3 Mix the resin with 100% ethanol in 1:1 proportion to obtain 50% resin. Mix it well.
8.2.4 Dehydrate the samples for 5 minutes in each dilution of ethanol starting from 30% and
ending with 100% anhydrous ethanol dried on molecular sieve. Remember, the samples must

never dry completely.

8.2.5 Infiltrate the samples first in 50% resin for 30 minutes, next in 100% resin for one hour, and
then again in 100% resin overnight. Perform all infiltration steps with constant slow shaking.

8.2.6 The next day, place the samples in fresh 100% resin for one hour and then embed them
between fluoropolymer embedding sheets. Degrease pieces of embedding sheet with ethanol,
and flat embed the samples between two layers of it, using two glass slides as support. Try to
avoid air bubbles in resin on or close to the sample.

8.2.7 Cure the samples in the oven at 70 °C for at least 48 hours.

8.3. Trimming and mounting

8.3.1 Separate embedding sheets and cut a piece of the embedded sample (approximately 1 mm
x 1 mm) with a razor blade. Transfer it to a parafilm. This will minimize the danger of losing the

sample due to electrostatics.

8.3.2 Take an aluminum pin that has been degreased with ethanol. Mix a conductive epoxy well
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and use a little amount of it to mount the sample to the pin. Cure conductive epoxy at 70 °C for
10 minutes.

8.3.3 Trim each side of the sample block with the diamond knife and then polish the face of the
block until the tissue is exposed.

NOTE: At this step, confirm the presence of a region of interest by collecting some sections and
performing toluidine blue staining® or checking under the electron microscope.

8.3.4 Reduce the size of the sample as much as possible. Then ground the sample to the pin with
conductive paint and cure it (for 24 hours at room temperature or in the oven at 65 °C for 40
minutes).

8.3.5 To minimize charging artifacts, sputter coat the samples with a thin layer of gold or
gold/palladium.

9. SBEM imaging

9.1 Place the pin with a sample into the chamber of the serial block-face scanning electron
microscope. Align the sample to the knife. Close the chamber and set the parameters.

9.2 Collect a stack of images at desired magnification, pixel size, slice thickness, accelerated
voltage (EHT), aperture, pressure, etc.

NOTE: The parameters depend on the sample and the goal of the experiment. Exemplary initial
imaging settings are included in the table of materials.

10. 3D reconstructions

NOTE: For the steps mentioned below we use open-access software e.g. FijiJl’ (Imagel version
1.49b), Microscopy Image Browser (MIB)8 and Reconstruct!® but various other software can be
employed.

10.1 Convert digital micrograph (dm) files into TIFF format. First import the image sequence (in
Fiji): File > Import > Image sequence > Choose 8 Bit Format) and then save as TIFF (in FijiJ: File >
Save As > Image Sequence > Choose Tiff).

10.2 Adjust brightness and contrast of the stack of images (in FijiJ: Image > Adjust >
Brightness/Contrast) and, if necessary, denoise it (use DenoisEM plugin for FijJ 2° : Plugins >

DenoiseEM > Denoise).

10.3 Align the stack. (in FijiJ: Plugins > StagReg or MIB: Dataset > Alignment Tools).
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10.4 Segment dendritic spines and synapses. (In MIB or Reconstruct software, comprehensive
tutorials are available (See Table of Materials for details).

REPRESENTATIVE RESULTS:

Using the method described above high contrast, good resolution images of the mouse brain
tissue can be obtained. A large field of view provided by the SBEM technique facilitates precise
selection of the region of interest. We took the large image of the CA1 region of the hippocampus
to measure the length of stratum radiatum (SR) (Figure 2A) and to set the imaging precisely in
the center (Figure 2B). Next, the stack of images was acquired and the objects of interest, such
as dendrites, dendritic spines, postsynaptic densities of the synapses were segmented (Figure
2C,D).

The use of the SBEM technique gives the possibility to analyze a relatively large volume of tissue
and to recognize rare events such as a multi-innervated dendritic spine (Figure 2E) — a particular
type of synapses that is characterized by several presynaptic terminals contacting the same
postsynaptic spine?!.

[Figure 2 HERE please]

The presented protocol for SBEM sample preparation allowed us to obtain high-quality images
of the brain tissue with heavily contrasted membranes, which enables easier segmentation and
reconstruction of membrane surrounded structures. The standard fixation with the higher
concentration of PFA (Figure 3B) and the two-step fixation approach resulted in similar tissue
morphology (Figure 3A).

[Figure 3 HERE please]

The results are reproducible, meaning that every specimen prepared using this protocol, not only
brain tissue but also the monolayer of cultured cells, was well contrasted.

The use of mild primary fixation offers the opportunity to use the tissue also for
immunofluorescence studies involving a light microscope. In the case of the PSD-95 antibody, we
did not observe the difference in immunostaining results between the samples fixed with two-
step fixation (mild primary and then secondary with a traditional fixative) and the one obtained
using traditional fixation with 4% PFA only (Figure 4A and 4B, respectively).

[Figure 4 HERE please]

FIGURE AND TABLE LEGENDS:

Figure 1. Schematic representation of the workflow for the dendritic spines preparation for the
analysis with SBEM. Mice were sacrificed and perfused with a mild primary fixative. The brain
was cut into halves, and one hemisphere was postfixed with immunofluorescence (IF)-dedicated
fixative, cryoprotected, sliced using a cryostat and processed for IF studies, while the other
hemisphere was postfixed with EM fixative, sliced with the vibratome and prepared for EM
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studies. Brain slices for SBEM studies were contrasted, flat embedded in resin, then a CA1 region
of the hippocampus was mounted to the pin, and imaged with SBEM (Figure 1). The part of the
protocol highlighted in a yellow box was featured in the video.

Figure 2. Dendritic spines in mouse hippocampus CA1 region. Representative image of mouse
hippocampal CA1 region. Stratum radiatum (SR) is shown with a white arrow (A). The region in
the middle of SR was chosen for imaging (B). Reconstruction of a piece of dendrite with dendritic
spines (C). Reconstruction of dendritic spines in a volume of tissue (D). Reconstruction of a multi-
innervated dendritic spine (E). Two presynaptic terminals contacting the same postsynaptic spine
are shown (in magenta and green).

Figure 3. Morphological details. With the use of the protocol presented here good quality images
showing the morphology of synaptic vesicles, PSD and mitochondria were obtained. Brain tissue
fixed with two-step approach (A) or with a standard fixative (B). Scale bar 2 um.

Figure 4. Comparison of PSD-95 immunofluorescence in samples fixed with various protocols.
Representative microphotographs of PSD-95 immunostaining in the stratum radiatum layer of
CA1 area in the dorsal hippocampus. (A) Confocal image after mild primary fixation followed by
postfixation with a standard fixative. (B) Confocal image after standard, stronger fixation. Scale
bars: 5 um.

DISCUSSION:

There are many variations of the primary NCMIR method described by Deerinck in 2010, The
basic principles remain the same but, depending on the type of material studied, slight changes
are implemented. It was described previously that different resins can be used to embed
specimens for SBEM and for example in the case of plants, Spurr’s is the resin of choice due to its
low viscosity that allows better infiltration through the cell walls?> 23, Moreover, various buffers
can be applied for fixation (e.g., cacodylate buffer, HEPES, or phosphate buffer as well as a
different concentration of glutaraldehyde (2-3%) and paraformaldehyde (2-4%)?3-28). The use of
tannic acid to enhance staining of samples rich in extracellular matrix?° or ruthenium red to
improve staining of plant material?® 3° are another amendments that can be used. As far as
dehydration is concerned usually ethanol and/or acetone are recommended for epoxy resin?* 28,
The same protocol as described here, or very similar, has been successfully used before by our
team and other groups® > 24. Samples processed according to this method are compatible with
TEM imaging3!. In comparison with the original NCMIR protocol published in 2010° we introduce
some minor changes such as replacement of toxic cacodylate buffer during fixation and osmium
post-fixation step with a phosphate buffer. As mentioned above, diverse buffers can be used
during EM preparation, and according to our experience, non-toxic PB gives satisfactory results.

Another change is a replacement of acetone with less user-harmful ethanol during the last step
of dehydration. Ethanol was also used as a resin solvent during the embedding process.

Moreover, DMP-30 was used instead of epoxy resin component C, as published before3% 33,

Due to the need to use the same brains for immunofluorescence studies the two-step fixation
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approach was introduced. First, the animals were perfused with a buffer containing a lower
concentration of glutaraldehyde (mild primary fixation by perfusion with a buffer containing 2%
PFA and 0.5% GA) and after that only half of the brain dedicated to EM was further postfixed with
a higher concentration of glutaraldehyde (2% PFA and 2.5% GA), while the other half of the brain
was postfixed with a standard fixative for immunostaining (4% PFA). The use of EM fixative with
a lower concentration of PFA was published before by others and our group® > 3% 34, The two-
step fixation presented here is as sufficient as a traditional one-step approach (Figure 3 and
Figure 4). However, since we propose that each half of the brain can be processed separately,
our protocol allows to reduce the number of animals used. Mild primary fixation successfully
maintains tissue antigenicity, enabling further immunofluorescence as demonstrated for the
antibody against PSD-95 protein. It has to be emphasized, however, that the utility of our
approach has to be validated for other antibodies.

The presented method results in high contrast images of the brain tissue with clearly visible
membranes. It is worth mentioning, however, that there are the same steps prone to failure, as
in the case of any other method of SBEM sample preparation, and particular attention needs to
be paid to them. The quality of the tissue morphology itself depends mostly on the perfusion. It
is a critical step, as only successfully fixed specimens give satisfactory results. Unfortunately,
fixation perfusion is influenced by individual variability among animals, thus the quality of images
may vary from one animal to another. Moreover, one has to be careful not to dry the specimen
during dehydration; otherwise, the sample will not be infiltrated properly with the resin. Another
important aspect is sample mounting to the pin. The epoxy resins are nonconductive, and
therefore they accumulate electrons during imaging what causes charging artifacts. To reduce
the charging effect in SBEM, it is necessary to carefully remove excess of resin at every side of
the specimen and accurately ground the sample with silver paint and sputter coating.

The current protocol focuses on brain tissue; however, it can be adapted for cell monolayer,
organotypic slices, or other tissues. Like the original NCMR protocol, the one presented here
results in highly contrasted samples that are suitable not only for SBEM, but also for FIB-SEM and
ATUM-SEM experiments.
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